Introduction to Parametric Modeling
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Introduction to Circular Pattern – Flower Pot

Introduction to Circular Pattern – Flower Pot
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Prerequisite Knowledge
Previous knowledge of the sketching commands Line, Circle, Add Relations, Smart Dimension is required to complete this lesson.  Previous examples of Revolved Boss/Base, Cut Extrude, Chamfer, Fillet, Shell and Adding Appearance should also have been completed.
Focus of the Lesson
On completion of this lesson you will have used:
· The Line, Centerline, Circle, 3 Point Circle, Add Relation, Convert Entities and Smart Dimension commands from the Sketch Toolbar.

· The Revolved Boss/Base, Cut Extrude, Chamfer, Fillet, Shell and Circular Pattern commands from the Features Toolbar.
Circular Pattern is used when spacing multiple instances of one or more features around an axis.  The pattern will be created on the same face of the model as the initial feature to be patterned.  This is called the Seed Feature. 
The Property Manager of the Circular Pattern controls the layout of the pattern. To create the pattern an axis must be chosen to revolve around. Other parameters to be set include the degrees of revolution, the number of instances and whether these will be equally spaced.  The pattern can be modified to allow certain instances of the patterned feature to be skipped.
Commands Used
This lesson includes Sketching (Line, Circle, Centerline, Add Relations, Convert Entities and Smart Dimension), Revolved Boss/Base, Cut Extrude, Chamfer, Fillet, Shell, Circular Pattern and Add Appearance.
Where to start?
It is important to analyse the design of a flower pot prior to starting the model. The model is created by revolving a sketch so that the axis for the feature will provide the axis for the circular patterns on the base.
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   Sketch to generate feature


     Revolved feature


Getting started

Create a new part.  Save the part as Flower Pot in your chosen location.
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Choosing a plane
Left click on the Front plane in the FeatureManager tree and choose Sketch  
.

The view will automatically change to a front view.
When creating a sketch, the following sequence is considered good practice:
    Sketch – Add Relations – Add Dimensions – Fully Defined Sketch
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Creating a sketch

Click the Sketch tab from the CommandManager.  
Select the Line command.
From the origin create a sketch similar to the one below.
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Adding Relations
Select the Add Relation icon from the Display/Delete Relations tool to display The Add Relations PropertyManager 
Select the two lines indicated (in green) and choose Parallel in the Add Relations property manager.  Click OK from the PropertyManager.  The parallel relation is added.
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Add Dimensions
Select Smart Dimension from the sketch toolbar and dimension the sketch as shown across.



Note – The sketch will change from blue to black when it is fully defined. 
Confirm the sketch.




Creating the feature 
Click the Features tab from the CommandManager to display the Features toolbar.  
Select the Revolved Boss/Base tool to display the Revolve PropertyManager.
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The sketch rotates to a trimetric view.  In the Revolved Boss/Base Propertymanager select the 150mm vertical edge of the sketch as the axis for the revolution.  At this point a preview of the feature will appear.


 

Click OK button         to create the feature. 
Completed feature:
This is the first completed feature of the part. The sketch has been absorbed into the Revolve1 feature in the Feature Manager.
Renaming a feature:
Select [image: image64.png]Multi-thickness Settings &

o [10.00mm ]

1|




 in the Feature Manager Tree, press the F2 key and type the 
new name Main Body to replace “Revolve1”.
Creating the indents
on the base
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Creating the sketch
Rotate the model so that the bottom surface is visible.  Right-click the bottom face of the main body.  The bottom face is the Sketch plane and is highlighted in the Graphics area.  Click the Sketch tool from the Context toolbar.  Choose Normal to from the heads up toolbar.
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Select the Centerline Sketch command.  Draw a vertical centreline on the sketch plane from the centre.  
Click the Line tool and start a vertical line capturing a Coincident relation at the circular edge.

Press the letter A on the keyboard to access tangent arc mode.
Draw a semi-circle.  Click to complete the semi-circle and the software changes back to the Line command.  Draw a second line parallel to the first.
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Select the circular edge of the base.  Select the Convert entities command to convert this circle to a circle within the sketch. 
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Use the Trim Entities command to trim the circle to the required size. 
Select the Add Relation command. Select the centerline and the centre point of the semi-circle and in the Add Relation Property Manager make them coincident. 
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Using Smart Dimension apply the above dimensions to the circle. 
Confirm the dimensions and exit the sketch.
Creating the feature 

Click the Features tab from the CommandManager to display the Features toolbar.  

Select the Extruded Cut tool to display the Extrude PropertyManager.  
Choose Isometric from the Heads-up View toolbar.  
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The feature previews in isometric. 
Extrude Feature Settings:
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End Condition = Blind

Depth = 4mm

Click the OK button to create the feature. 
Rename the feature Base Cut.
Adding a Chamfer
A 4 mm chamfer will now be added to the top edge of the Base Cut.
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Rotate [image: image2.bmp] the model to view the base cut.  Select Chamfer from the Features toolbar.
In the Chamfer Property Manager select the top edge of the extruded cut in the graphics area and insert the parameters as shown. 
Note: The flip direction check box will angle the chamfer inwards.
Confirm [image: image3.png]


 the feature.
Adding a Fillet
A fillet will now be added to the top and bottom edges of the chamfer.
[image: image36.png]| Features | Sketch | Surfaces | Sheetletal | Evaluate | DimXpert | Office Products

CIEIT T el

3 Front plane
Revolve Parameters A X Top Plane:
- L. orign
(@] [onedrection V|| %60 manssay
Comw ]z TR
terge resut @) Filert

4 bose Patten
Base Cut Pattern

Crear Hole
4 base Circles Pattem

& sictcrs




Select Fillet [image: image4.png]


 in the Features Toolbar.

In the Fillet Property Manager set the Fillet radius to 2mm and the select the top and bottom edges of the chamfered cut in the graphics area.
Confirm [image: image5.png]


 the feature.

The completed feature should now look like this (above).
Pattern the Feature
The Base Cut can now be patterned on the bottom surface of the model. 
In the View menu activate the Temporary Axes.  The axis from the original Revolved Boss/Base will become visible.
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Choose the Circular Pattern Command from the features toolbar.
In the Circular Pattern Property Manager select the visible axis, instances (4) with equal spacing.
Expand the Feature Tree of the Flower Pot (left click on the + sign) in the graphics area and select Base Cut, Chamfer1 and Fillet1 as the Seed Features to pattern. 



 Click OK [image: image6.png]


 to create the pattern.

Rename Feature
Rename the feature Base Pattern 
Shell Command
It is important to shell after the cut feature on the base has been patterned.  If the shell was created first the 4mm deep indents could not have been created in a shelled feature 1mm thick.
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Select the Shell command on the Features toolbar.
In the Shell Property Manager 
· Distance = 1mm

· Select the top surface of the model.
· [image: image39.png]


Tick Show Preview
Click OK [image: image7.png]&



 button to create the pattern.
Rename Feature
Select the Feature in the Feature Manager Tree and  press the F2 key.  Rename the feature Base Cut Pattern.
This is how the completed shell feature should look.

Creating the holes
A circular hole is created first on the base and then patterned.
Creating the Sketch
Click the Sketch tab from the CommandManager.  The Sketch toolbar is displayed.  
Rotate the model to view the bottom surface.  Left click on the surface and select Sketch.  Choose Normal To from the Heads-up View toolbar.
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Select the Centerline Sketch command. Sketch two centerlines from the centre of the circle to the circumference of the base circle.  Add Relations to make one horizontal and Smart Dimension the angle between them to 450.
Select the Circle Command. Sketch a circle centred on the centerline and Smart Dimension as shown. 
Click OK [image: image8.png]


 to complete the sketch.
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Finish the sketch by clicking on the Exit Sketch icon or Exit Sketch in the Confirmation Corner.
Creating the Feature 
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Click the Features tab from the CommandManager.  The Features toolbar is displayed.  Select the Extruded Cut tool.  The Extrude PropertyManager is displayed.  Choose Isometric from the Heads-up View toolbar.
In the Cut Extrude Feature Manager set the direction to Through All. 



Click OK to complete the feature.
Rename the feature Circular Hole in the Feature Tree Manager (F2 key).
Pattern the Feature
The Circular Hole feature can now be patterned with similar settings as the previous Circular Pattern. 
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Select the same axis as previously; instances (8) with equal spacing (above left).
Expand the Feature Tree in the graphics area and select Circular Hole as the feature to pattern.
In the Options box, deselect Geometry Pattern.
Click OK to complete the feature.
The model should now look like this (above right).
Rename the Feature
In the Feature Manager Tree rename the pattern Base Circles Pattern.
Note: It is advisable to save the part at regular intervals. This can done using the Quick save [image: image9.bmp] button.
Adding an edge
A protruding edge is added to top of the Flower Pot.  Sketch the profile below on the Right plane.  Zoom to [image: image10.bmp] the top corner. The graphics area will enlarge the selected area.
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Select the Line command and sketch the diagram above.  Add Parallel and Equal relations as shown (above left).  Smart Dimension as shown (above right).
Creating the feature 
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Click the Features tab from the CommandManager.  
Select the Revolved Boss/Base tool.  The Revolve PropertyManager is displayed
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In the Revolved Boss/Base feature Propertymanager select the axis of the cylinder as the axis for the revolution.  At this point a preview of the feature will appear.
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Click OK          button to create the feature. 

Rename the feature Rim.
One last Fillet


Add a 1mm fillet feature to the underside surface of the external rim. 
Adding an appearance to the Flower Pot.
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Right click on any face of the model and choose Appearance Callout
A drop-down menu appears with the various aspects of the model in hierarchical order.

Click on the colour swatch next to the part name, Flower Pot.
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Choose Plastic, Medium Gloss, green medium gloss plastic.

The green medium gloss plastic is applied to the entire part.
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Choose OK
Save [image: image11.bmp] the completed model.
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Further Exercises
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